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Leaver-Toaster using 
 

______________________________ 

 

Goal : How to use the Leaver module from Toaster plugin  

 

Note 
The L-Toaster plug-in is composed from the three distinct tools: the Leaves Analyzer, the 

Leaves with aids Analyzer, and the Education Leaves Analyzer. It proposes batch image 

processing tools. 
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1. Toaster running 

 

The Toaster plug-in is run from the ImageJ
1
 application. So, 

 

 Run ImageJ… 

 Select the launcher item of the Toaster sub menu of the plugins menu 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

2. Toaster setting 

 

The Toaster plug-in manages the working folders and the export format: the user can 

specify where find input data or achieve output results,… and this once and for all. 

 

 Select the modify item of the Preferences menu 

 

 

 

 

 

 

 

 

                                                 
1
 ImageJ is an open-source software developed by the National Center for Biotechnology Information (NCBI), 

for the images processing and analysis. It is distributed under GPL licence. 

 

 

Im. 1 : ImageJ et le plugin Toaster 

Img. 2: the folders setting 
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2.1. The working folders 

 

In the working folders page, set the different fields from the corresponding browsers (the 

buttons located at the left of the text fields) (see img 3.). Save the settings if you want the 

application uses it at each time; in other case, Apply only the settings (see img 2.).  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Note: rules of colors (fig 4.) 

Different colors are used to indicate the specified paths. 

 In black: validate path already used – the indicated folder exists and has been 

already used 

 In blue: path modified by the operator– the indicated folder exists when it is 

selected from the browser 

 In red: invalidated path – the indicated folder does not exist on the current 

computer; you should give a good path. 

 

 

 

 

 

 

 

 

 

 

 

 

 

The fields : 

 

input images : folder in which the plug-in takes the images or the repertories containing 

the images to process. 

 

Img. 3 : how to set working 

folder 

 

 

 

 

 

 

 

Img. 4 : rules and colors to specify the working folders 
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output images : folder where the plug-in saves the results images, i.e. the visual outings 

used to check the processing. 

 

output results : folder where the plug-in saves the results files, i.e. the numerical outings 

produced by the processing. 

 

temporary files : folder where are achieved the temporary files. 

 

 

Note: folder syntax (fig 4.) 

The working folders are normally given by their extend name, that is to say from the root. 

However, a relative path can be displayed. The “.” means the local ImageJ folder, that is 

to say the repertory where is installed the ImageJ application. 

 

2.2. The export formats 

 

In the page output format, set the different fields using the drop-down list (voir img 5.). Save 

the settings if you want the application uses it at each time; in other case, Apply only the 

settings (see Img. 5).  

 

 

 

 

 

 

 

 

 

 

 

The fiels : 

 

Images format: concerns the format of graphical results. Several graphical formats are 

available: bmp (BitMaP), gif (Graphics Interface Format), jpeg (Joint Photographic 

Experts Group), png (Portable Network Graphics) and tiff (Tagged Image File Format). 

 

Results file format: concerns the format of numerical results. Several standard formats are 

available: txt (TeXT), csv (Comma Separated Values, loadable by the usual spreadsheets). 

 

 

 

 

 

 

 

 

Img. 5 : format des fichiers d’export 
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3. Data loading 

 

Different modes are available: load (and process) only one file, or load (and process) all 

the files of a folder. 

 

3.1. I want process only one file 

 

Use the first submenu of the files menu… A browser is then opened and allows selecting 

THE file to process. 

 

 

 

 

 

 

 

 

 

 

 

 

Note: results 
The output data (image file or/and results file) will be saved into the output folders under 

the same root name as the selected file. 

 

3.2. I want process several files 

 

Use the second submenu of the files menu to select several files. A browser is then opened 

and allows selecting A file of the folder to process. All the files of the folder where is the 

selected file will be processed. 

 

 

 

 

 

 

 

 

 

 

 

Note: results 
The output data (image file or/and results file) will be saved into under the same root 

name as the selected file, achieved in a subfolder created in the output folders. 
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Warning: the input folder has to contain only image files produced from the same 

settings, with the same optical resolution (value generally given in dpi).  

 

 

4. Leaver opening 

 

The Leaver plug-in is ran by the green leaf icon in the tools bar of Toaster 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Note 

 At least one image must be loaded before the Leaver running. 

 In the second case, the aids should be given on a numeric image produced according to 

the protocol applied for the leaves study; the produced image will be named “aids.jpg” 

and put in the folder of the images to process. 

 

 

 

 

 

 

 

 

 

 

 

 

to process single images containing 

several leaves arranged by line 

Derived version for Education: 

does not integrate the petioles 

deletion. 

to process images containing several 

leaves arranged by line containing 

some additional aids (rule, stickers,…) 
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5. Leaver setting 

 

The following dialog box allows adapting the processing to the current (set of) image(s). 

Three aspects are concerned: the metrical aspect to define the significant object sizes, the 

processing aspect and the managing aspect giving the working folders and the export 

formats. 

5.1. The Managing aspects 

 

The managing aspects are set from the Preferences panel of the Toaster plug-in (see §2). 

Are editable the following fields: 

 

Output images - path: extend name of the folder where will be achieved the output 

images.  

This field is set from the Toaster settings. These images are built to avoid a visual 

checking after data treatment. The leaves are colored in regard to their position in the 

treated image: the hue depends on the line, and the saturation on the row in the line (§7). 

 

Output results - path: extend name of the folder where will be achieved the output 

results.  

This field is set from the Toaster settings. These files contain the numerical values of 

calculated parameters, sorted by natural reading order of leaves – from left to right, from 

up to down. 

 

Output results - saving: the way to archive the results 

 

 Only one results file: the results of all read input files are written in only one 

output file. 

The output file takes the name of the input folder (when several files are 

processed) or of the input file (when only one image is treated). In the results file, 

each line corresponds to one leaf; its name is defined by the following way: 

[image_name] , [number of line]_[ row of leaf into the line]. 

 

 One results file per image: the results area saved image per image, in different 

files. 

The output files follow the same organization as the input file. In each results file, 

each line corresponds to one leafof the corresponding image; its name, called 

identifiant, is defined by the following way: 

[number of line]_[ row of leaf into the line] 

 

Output images format: give the format of the output images 

 

Output results format: give the format of the output numerical files 

 

The csv files are loadable by the usual spreadsheet; the txt files can be imported in the 

usual spreadsheet. 

 



              Tree and planT organs and structures analyzer L-Toaster Using – v.2.2.2  
                                           How to get geometric parameters of Homogeneous Leaves from desktop scanner  

P. Borianne 8/16 7th March 2010 

 

 

5.2. The processing aspects 

 

Internal - measures: defines which parameters (see §8) will be evaluated: 

 

 Default measures: only the area, the length and the width of each found leaf will 

be returned ; length and width are defined by the radius of the fitted ellipse; 

 Use IJ measures setting: all parameters selected into the “set measurements” 

dialog box of the ImageJ platform (see analyse / set measurements for more 

details) will be evaluated. 

 

About petiole: defines the processing that will be applied 

 

 merge: the petiole is merged to the blade; the results include the two parts. 

 delete: the petiole is suppressed before computation; the results concern only the 

blade. 

 

5.3. The metrical aspects 

 

They avoid defining the sizes of the significant objects. Two cases are possible: 

 

Case of TIFF images 

 

Only two parameters are : 
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Morpho – leaf minimal size: this is the minimal size, given in squared millimeters, of 

significant object: all object having an area smallest than the given value will not consider 

as leaf and will be excluded from computation.  

 

Morpho – hole minimal size: this is the minimal size, expressed in squared millimeters, 

of significant hole : all hole having an area smallest than the given value will be filled.  

 

Scale factor: for the tiff images, the pixel scale factor is valuated from the optical 

resolution read in the header of the image.  

 

 

Case of other images 

 

Three fields are editable: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Input – pixel size: this is the scale factor, i.e. the size in millimeter of the pixel height (or 

width). This value is given subdividing 25,4 (the millimetric value of the inch) by the 

optical resolution of the image, given in dpi (dot per inch). The dpi is set for the 

digitalizing step, or read from an images editor such as Gimp
2
. 

 

 

 

 

                                                 
2
 The GIMP is an freeware to create and manage images and numerical photography. 
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Morpho – leaf minimal size: this is the minimal size, given in squared millimeters, of 

significant object: all object having an area smallest than the given value will not consider 

as leaf and will be excluded from computation.  

 

Morpho – hole minimal size: this is the minimal size, expressed in squared millimeters, 

of significant hole : all hole having an area smallest than the given value will be filled.  

 

 

6. Leaver running 

 

The Leaver plug-in is ran when you validate your settings: click on button “ok”. 

 

 

7. Example 

 

7.1. Data and results 

 

The input data are six tiff images located into the folder A317 

 

NB: here, the images are produced by scanner: they are seen from under.  

 

 

The settings of the §5 give the following output data: 

 

 the checking  images achieved in the folder E:\\Toaster\OutputImages\A317 

 

 

 

NB: the images are reversed by vertical symmetry; so, they are seen from above, like 

their disposition on the scanner pane. 

 

 

 One results file, named A317.txt, achieved in the folder E:\\Toaster\OutputResults 
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7.2. Coherence checking 

 

The coherence checking allows verifying the good ordering of results. For the large-scale 

analysis, it is important to check the weighing/areas coupling, without offset between 

weighing and geometrical measure. 

 

The lines are drawn with different hues to ease the visual post-checking. The intensity 

depends on the row of the leaf in the line. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

7.3. Accuracy checking 

 

The accuracy checking allows verifying the good 

segmentation of the images, i.e. the real accuracy 

of the leaf identification. 

 

The checking images are produced by overlay of 

the segmented regions on the native images. The 

anatomical structures of each leaf are seen by 

transparency to well appreciate the segmentation 

quality. 

 

 

 

 

 

 

Im. 6: incoherence of the coloration, incoherence of the results. Left: good 

coloration of the result image, even if several leaves are missing. Right: only one 

hue showing for several lines; the results are not well sorted and could not coupled 

with weighing.  
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7.4. Numerical results 

 

The results file, called here A317.csv, is achieved in the E:\\Toaster\OutputResults folder. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

This file is loadable in the usual spreadsheet, such as Excel. 

 

NB: the numerical values are given in Anglo-Saxon notation  

 

Each line corresponds to a processed leaf. The two first columns allow identifying the leaf in 

the images series: the first gives the image name, the second the line and the row of the leaf. 

 

NB: When the checking images show incoherence, the numerical file will be modified to ease 

the results processing.  
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8. Measurements 

 

8.1. Default measurements 

 

Area - Area of selection in square pixels. Area is in calibrated units, such as square 

millimeters, the calibration is made from the optical resolution given in dpi.  

 

Adjusted length and width – they are defined by projection of every point of the leaf on the 

primary and secondary axes of the best fitting ellipse; the lengths are given in millimeter.  

 

8.2. ImageJ Measurements setting... 

Use this dialog box to specify which measurements are recorded by Analyze/Measure and 

Analyze/Analyze Particles.  

 

 

 

 

 

 

 

 

 

 

Area - Area of selection in square pixels. Area is in calibrated units, such as square 

millimeters, if Analyze>Set Scale was used to spatially calibrate the image.  

 

Mean Gray Value - Average gray value within the selection. This is the sum of the gray 

values of all the pixels in the selection divided by the number of pixels. Reported in calibrated 

units (e.g., optical density) if Analyze>Calibrate was used to calibrate the image. For RGB 

images, the mean is calculated by converting each pixel to grayscale using the formula 

gray=0.299*red+0.587*green+0.114*blue if “Weighted RGB Conversion” is checked in 

Edit>Options>Conversions. or the formula gray=(red+green+blue)/3 if not checked.  
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Standard Deviation - Standard deviation of the gray values used to generate the mean gray 

value.  

 

Modal Gray Value - Most frequently occurring gray value within the selection. It 

corresponds to the highest peak in the histogram.  

 

Min & Max Gray Value - Minimum and maximum gray values within the selection.  

Centroid - The center point of the selection. This is the average of the x and y coordinates of 

all of the pixels in the selection.  

 

Center of Mass - This is the brightness-weighted average of the x and y coordinates all pixels 

in the selection.  

 

Perimeter - The length of the outside boundary of the selection.  

 

Bounding Rectangle – It is the smallest rectangle enclosing the selection. Uses the headings 

BX, BY, Width and Height, where BX and BY are the coordinates of the upper left corner of 

the rectangle.  

 

Circularity - 4pi(area/perimeter^2). A value of 1.0 indicates a perfect circle. As the value 

approaches 0.0, it indicates an increasingly elongated polygon. Values may not be valid for 

very small particles. For small particles, the circularity can be >1 (due to the definition of 

perimeter and area in a square grid). In those cases the value of 1.0 is returned (before v1.37 

this was set as -1.0).  

 

Fit Ellipse - Fit an ellipse to the selection. Uses the headings Major, Minor and Angle. Major 

and Minor are the primary and secondary axis of the best fitting ellipse (see §8.1).  

 

Angle is the angle between the primary axis and a line parallel to the x-axis of the image. 

Note that ImageJ cannot calculate the major and minor axis lengths if Pixel Aspect Ratio in 

the Set Scale dialog is not 1.0.  

 

 

Feret's Diameter - The longest distance between any two points along the selection 

boundary. Also known as the caliper length. The Feret's Diameter macro will draw the Feret's 

Diameter of the current selection on the image.  

 

Integrated Density - The sum of the values of the pixels in the image or selection. This is 

equavalent to the product of Area and Mean Gray Value. The Dot Blot Analysis example 

demonstrates how to use this option to analyze a dot blot assay.  

 

Median - The median value of the pixels in the image or selection.  

 

Skewness - The third order moment about the mean. The documentation for the Moment 

Calculator plugin explains how to interpret spatial moments.  

 

Kurtosis - The fourth order moment about the mean.  
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Area Fraction - The percentage of pixels in the image or selection that have been highlighted 

in red using Image/Adjust/Threshold. For non-thresholded images, the percentage of non-zero 

pixels.  

 

 

8.3. About lengths 

 

Lengths and widths must be used cautiously: they depend on the leaf shape, and on the 

applied method. 

 

Without petiole deletion 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Arabica coffea 
Liberia coffea 

oak 

Ipomea  

Ipomea blade 

Mormodica 

Im 16 : leaves and lengths : in blue, the adjusted lengths, in orange the adjusted widths. 
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The lengths and the widths are here defined by projection of the  leaf points on the primary 

and secondary axes of the best fitting ellipse; this approach is rather adapted to the single, 

elongated and right leaf.  

 

With petiole deletion 

 

To come 
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